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WELCOME TO POS INVOICE TRAINING! 

We are delighted to teach you how to use POS Invoices in agrē! This guide is yours to keep. Feel free to 

write notes and comments in it for your future reference.  

What you’ll find: 

What is a POS Invoice? ........................................................................................................................... 2 

Logging On .............................................................................................................................................. 3 

Adding POS Invoices ............................................................................................................................... 5 

Fixing Mistakes ..................................................................................................................................... 24 

Toolbar Customization ......................................................................................................................... 34 

Configuration Options for POS Invoices ............................................................................................... 34 

 

 

What is a POS Invoice? 

A POS Invoice is an abbreviated version of the regular agrē invoice that’s designed for speed! You can use 

a barcode scanner to quickly enter items onto the invoice, take the customer’s payment, and print the till-

tape receipt. Even without a barcode scanner you’ll be able to enter a POS Invoice quickly using special 

keyboard shortcuts.  

POS Invoices are much faster to enter but the trade-off is less flexibility - 

you aren’t able to add blends, or indicate a shipping address, there’s no 

place for flagging purchases as prepaid, selecting a Lot Number (Lot#) or 

adding customer order number; you can’t link to or import from a loadout 

ticket or work order, and some payment types may not be acceptable.  

POS Invoices are formatted to print on “till-tape” instead of on an 8½ x 11 

sheet of paper (but there is an option to print them that big if you need to). 
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Logging On 

You will have received your Citrix ID and password, as well as your own agrē User Name and password, 

from your supervisor or from Tronia Support. 

• navigate to www.tronia.com 

and then click Hosted Login. 

 
 

Tip If you are unable to access the Hosted Login link, you can 
navigate directly to the login page: https://citrix.tronia.com 

• in the User name and 

Password boxes, enter your 

Citrix ID and password. 

• click Log On. 

  

• click agrē 

 

 

• in the User Name and 

Password boxes, enter your 

agrē user name and 

password. 

• click OK 

 

• your training database can 

be used in conjunction with 

this guide 

 

https://citrix.tronia.com/
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• your agrē database opens and you’re ready to start adding POS Invoices 
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Adding POS Invoices 

New POS invoices are added from the Accounts Receivable menu or from the toolbar quick button  

(see page 34 to add if you don’t see it). 

 

 

fields with red stars * are mandatory, others are optional 

Speed Tip Press the TAB key to advance to the next field instead using of the 
mouse. 
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Start by typing or scanning the Membership Number. If your customer cannot remember their member 

number, or they can remember only part of their member number, please ask their name then click Find 

to search for them.  

 

Quick Search looks at several fields for the text you type and returns all matches. For example, when 

quick searching for 436, the results would include all members with 436 as part of their member number 

as well as all members with 436 as part of their phone number. That could be a lot of members. 

 

To narrow down the list of results, type what portion of the member number they can remember in 

Customer Code (which looks only at member number, not name or any other field) and/or type their 

name in Quick Search, then click Find. 

Highlight the member then click Use Selection. 

If you cannot find a member after searching using different criteria please consult with your supervisor.  

If the customer is not a member, use the Non-Member number. If you can’t recall the non-member 

number, you can Find it the same way. 

 

If your association has multiple Non-Member accounts confirm with your supervisor which one to use. 
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Adding Items to POS Invoices 

Adding Items with a Bar Code Scanner 

Scan the first item. The scanned item is added to the POS Invoice with a default quantity of 1.  

 
 

Increasing Quantity of Scanned Items 

If the member is taking more than one, you can scan the item again (which appends another product row 

of the same product with a quantity of 1), or edit the product row by double-clicking or by pressing either 

Edit Product or F10, and increase the quantity. 
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Note If the scanned UPC is not found, inactive, or associated with multiple items 
you’ll be prompted to add the item manually.  
Scanning the item again will open the Add Product window automatically. 

 

 

 

 

 

Adding Items Manually 

If you’re not using a barcode scanner, add items manually by clicking the Add Product button, or by 

pressing the F9 function key.  

 

Start by typing the Product Code. If you are unsure of the code, click Find to search for it. 
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Quick Search looks at several fields for the text you type and returns all matches. For example, when 

quick searching for reg, the results would include all items with reg as part of the product code as well as 

all items with reg as part of the product description, UPC, or manufacturer. 

 

Type what portion you can remember in Quick Search, then click Find. 

If a long list of items is retrieved, you can use additional criteria to narrow down the results. Try selecting 

a Product Group, Product Type, Manufacturer, or Brand, then click Find again. 

 

Highlight the item then click Use Selection. 

 

If you cannot find an item after searching using different criteria please consult with your supervisor.  
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Products added manually don’t have a default quantity so you’ll need to enter one before you press F9 or 

click the button to Update. 

 

 

Speed Tip If you’re not using a barcode scanner press the TAB key to advance 
to the next field instead using of the mouse. 

 

For prepaid fuel purchases (and other items with tax-included pricing) you can enter the Unit Price and 

the Line Total, then agrē will calculate the Quantity for you. 
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Removing Items 

To remove a product row, select it and press F11 or click Delete Product. 

 

To confirm the deletion, click Yes. 

 

Speed Tip Enter = No 
Tab, then Enter = Yes 
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Editing Items 

To edit a product, select the row and either press F10, double-click it, or click Edit Product. 

 
 

 

 

When editing items you can change the Unit Type (which will likely change the price). 

 



CRS Cashier Training  Page 13 of 36 

You can also change the Quantity. 

If the Check Inventory warning blinky appears, it means the Quantity on Hand is less than the Quantity 

the member is taking. Finish the transaction, take note of the item, and notify your supervisor.  

 

If you’re looking up availability of an item (the item is not actually present) click Details then Show Other 

Locations to see if another location within your association has more on hand. 



CRS Cashier Training  Page 14 of 36 

The default price should automatically populate for the item but if it doesn’t, or you need to change it, 

click Pricing and review the Current Prices tab, the Sale Prices tab, and the Sales History tab (security may 

restrict what you can select) to choose the best applicable price. 

 

No default price, a price of $888.88, or an unusually high price are all indicators the price must be 

changed. 
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Finalizing the Transaction 

Emailing the Customer Receipt (optional)  

Before accepting payment, ask the customer if they would like the receipt emailed to them (please 

confirm with your supervisor that emailing is available). 

 

The Customer Email address will default to the email address(es) on the Customer tab of their account. 

The invoice/receipt can be emailed to more than one email address, just separate them with a semi 

colon.eg. l.martin@martinfarms.com; pat@agroaccountingsolutions.ca  

 

Full Size Invoice  

You can just print a regular invoice report, or you can flip from a POS invoice to a full invoice. 

Print Full Invoice 

Before accepting payment, check Print Full Invoice if the customer would prefer an 8½ x 11 full-size 

invoice/payment receipt printed from a regular printer, not the till tape printer (please confirm with your 

supervisor if/when to ask the customer if they want a full size invoice/receipt).1 

 

The option of a full-size invoice/receipt may be based on the items being bought. For example, at your 

association cashiers ask the customer when anything with a warranty - like batteries - is purchased. 

When printing a full-size invoice/receipt no Merchant Copy is printed. 

                                                            
1 Print Full Invoice may be checked by default, but it can be unchecked if needed.  

mailto:l.martin@martinfarms.com
mailto:pat@agroaccountingsolutions.ca
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Flip to Full Invoice 

If you need to switch the customer’s purchase to a full-size invoice, select Full Invoice. 

All the details you have entered so far will be copied to the full invoice. 

 

For example, a full invoice is needed to flag a purchase as Prepaid or to add a Lot Number. 

Accepting Payments 

Immediate payment is required for all POS Invoices. 

After all items have been added, click Total or press F12 to accept payment. 

 

 

some customers or products may require a full invoice 
if prompted, select Yes/OK to flip and add the required information 
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The Invoice Payment window opens and defaults to the tender area.  

Start typing the 1st letter of the payment type (e.g. “c” for cash) then press “c” again or use the down 

arrow to scroll through all payment types starting with “c” (like Charge Acct), or use your mouse to select 

a tender type from the dropdown menu. 

 

If you selected the wrong payment type, or the member changes their mind about how they want to pay, 

select Remove Payment or press F10 to remove a payment type.  

 

 

 

Saving the Payment 

Save the Payment. If applicable to the payment type, the cash drawer will open automatically … 

 

 

 

 

… and a new POS Invoice pops up so you’re ready for the next customer. 
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Manually Opening the Cash Drawer 

If you accept payment by a tender type that doesn’t open the cash drawer automatically, it can be opened 

manually by pressing F1 or by selecting Open Drawer.  

 

Open Drawer works only if you have security permission and a compatible receipt printer set up in your 

configuration options (at either the company or user level - see Page 34) as it is the printer, not agrē, that 

sends the signal to the cash drawer to open. 

 

 

Cash Payments 

When the customer is paying with cash, tab over to the Amount Tendered and type in the amount the 

customer gave you. Tab once more and agrē will calculate the Change Due. 
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If you Save too early (before tabbing off)  agrē will not calculate the change. 

 

You’ll need to check the receipt and calculate the amount of change to return to the customer. 

 

 

Multiple Tender Types 

If the customer is paying with multiple tender types, agrē can do the math for you. Select as many tender 

types as you need. 
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Credit Override 

If a member who would not normally be able to charge a purchase has received permission to do so, you - 

or another agrē user with Credit Override security permission - can override the credit restriction and 

allow the member to charge the purchase. 

 

Notes Members with Credit Restriction A: Charge account credit restricted will not 
be allowed to Charge on Account - payment must be tendered at the time of 
sale. 
 
Members with Credit Restriction B: Charge account & cheque credit 
restricted will not be allowed to Charge on Account AND payment should not 
be tendered by Cheque (however this is not enforced by agrē). 
 
Credit Restrictions can be overridden by any user with security permission. 

  



CRS Cashier Training  Page 21 of 36 

Printing the POS Payment Receipt 

 

After the payment information has been entered and 

saved, the receipt will be printed automatically.  

The selected Default Report Printer config options 

(see Page34) determine to which printer agrē sends 

the POS Payment receipt, and whether it displays on-

screen first. 

 

Depending on the tender type settings: 

• a second Merchant Copy of the invoice may also 

display  

• the Merchant Copy may have a signature line 

for the member to sign (for example if the 

tender type is Charge on Account the member 

must sign it) 

Taxes for tax-included items are itemized. 
 

 

If you chose to Print Full Invoice the report criteria 

window may open. 

Select Preview and the full invoice will display. 

 

 

Print the invoice. 

An 8½ x 11 full-size combined invoice/payment 

receipt will print on a regular printer. 
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Reprinting the POS Payment Receipt 

Payment receipts for POS Invoices are reprinted from the Invoices home form. 

 

Accounts Receivable > Invoices (or click the Invoices toolbar button) 

 

 

All invoices created today are listed by default. You can Search for invoices created on other dates if you 

need to reprint one that is not shown. 

 

 

 

To reprint the invoice at full-size (8½ x 11) select Preview Item, then Print. 
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To reprint the invoice on till-tape, select Preview Receipt, then Print. 
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Fixing Mistakes 

If a mistake is made or details of the sale need to be changed, please consult with your supervisor 

for specific instructions on how to correct that particular error. Additional security permission may 

be required to correct some types of mistakes. 

Any changes in agrē must match mainframe so additional steps outside of agrē may be required. 

Here are some guidelines (retails may have their own specific policies): 

 

SAME DAY Invoice Edits   

An invoice can be edited only on the same day it was created. TLog data is sent to the mainframe every 

night, and once the mainframe receives an invoice it cannot be edited. 

Note If the error isn’t found until the NEXT DAY and the POS invoice has already 
been received by the mainframe, it cannot be edited. You’ll need to “return” 
the wrong product and “exchange” it for the right one (see Page 31 for more 
details about POS Returns). 

POS Invoices are edited from the Invoices window or from the Customer Account.  

 

Customer Account or 
Accounts Receivable > Invoices (or click the Invoices toolbar button) 
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Before an Invoice can be edited, you must Unapply Credits from the immediate payment.  

 

The Edit Invoice window opens. Make your changes. 

 

You will be unable to change the Invoice Date or the Customer, and any payments or credits applied 

originally will be reapplied automatically when Saving your changes. 

 

If you change your mind about making changes, click Exit.  

Then click OK to confirm. 
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1. SAME DAY Product Correction  

If the incorrect product error is caught on the SAME DAY the POS Invoice was entered, it can be edited 

(see Same Day Invoice Edits above), and the product corrected.  

 

The correct product may have different pricing so the customer may have over- or under-paid.  

Please confirm how to handle any pricing difference with your supervisor. 

 

 

If the error isn’t found until the NEXT day the POS invoice will have already been received by the 

mainframe and cannot be edited. You’ll need to “return” the wrong product and “exchange” it for the 

right one on a new POS Invoice (see Page 31 for more details about POS Returns). 
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2. SAME DAY Payment Type Correction   

Credits from a payment don’t need to be unapplied from the invoice before correcting the Payment 

Type.  

Payments can be edited from the Customer Account or from the Payments window. 

 

Customer Account 
or 

Accounts Receivable > AR Payments 

Select the correct Payment Type and Save the payment. 
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3. SAME DAY Invoice Delete   

CAUTION Deleting an invoice is not recommended! 

Processing a return (see page 31) is the preferred process to correct 
mistakes. Please consult with your supervisor before deleting any 
transactions. 

An invoice can be deleted only on the same day it was created. TLog data is sent to the mainframe 

every night, and once the mainframe has received an invoice it cannot be deleted. 

POS Invoices are deleted from the Invoices window or from the Customer Account. 

 

Customer Account 
or 

Accounts Receivable > Invoices 

A POS Invoice cannot be deleted until its immediate payment has been deleted so you’ll be prompted 

to delete both at the same time. 

 

All deleted invoices are included automatically in the Deleted Invoices data export. 

All deleted payments are included automatically in the Deleted Payments/Prepayments data export. 
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Returns & Correcting Past Transactions 

Please consult with your supervisor for your retail’s specific policy on returns.  

When a member is returning an item, you can easily look up their sales history and find the last price they 

paid. 

Create a new POS Invoice and select Return Invoice. 

 

For Items Purchased from Your Association 

1. Customer Return by Date Range/Sales History  

Date Range is the default. Details about products purchased in the last 30 days are displayed. 

Optionally change the Location if the product being returned was purchased elsewhere (click Refresh 

List to update). Check the item(s) being returned, enter the Quantity, then click Use Selected Rows. 
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The price, prepay status, taxes, cost, etc. of the return will match the sale but may be changed (to edit 

the price due to a restocking fee, for example). If you make changes you will be prompted to enter 

your override credentials (see #4 below). 

If the item was not purchased in the last 30 days, expand the date range or return by Product. 

 

 

2. Return by Product 

Choose This Product and scan the item (or type the Product Code/Item Number - use Find if you need 

to look it up), then click Refresh List. Check the item(s) being returned, enter the Quantity, then click 

Use Selected Rows. 

 

If the customer has no sales history for the item AND it is not an item that can be returned 

without proof of purchase, kindly tell the customer you are sorry but it appears that the item 

was not purchased from your association. You may want to consult with your supervisor. 
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3. Customer Return with Receipt   

If the customer is returning an item with the receipt, cross-reference the price shown on the sales 

receipt with the price of the return. 

Type the Reference Number from the original sales invoice and select Refresh List. 

Check the item(s) being returned, enter the Quantity, then click Use Selected Rows. 

 

 

For all Returns 

The item(s) are added with a negative Quantity and the return Price matches the sales price 

automatically. 

Select Total to issue a refund. 
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Match the Payment Type to the tender type on the original sale. 

 

All returns require a customer signature on the Merchant Copy. 

Please consult with your supervisor before putting returned items back into inventory as not 

all returned or exchanged products will be suitable for resale. 

Exchanges 

If the customer is exchanging the returned item 

for another, add the additional item manually or 

by scanning so that the transaction balances to 

$0 (returning an item and scanning the same 

item from off the shelf).   

 

The Return Receipt includes the sales invoice 

number. 
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4. Customer Return with No Proof of Purchase - Requires Override 

If the customer did not purchase the item from you, it can be added manually. You may 

need to consult with your supervisor. 

These types of items may be: 

• drums or totes purchased elsewhere for return of deposit 

• Private Label items and your retail’s policy states those items can be returned 

without question 

• your retail’s policy is to return all items you know you stock without question 

Start a new POS Invoice and check  before scanning the item. 

A user with permission to return unpurchased items must enter their agrē User Name and Password. 

Override permission must be granted each time a return product row is added. 

 

• If you have override permission, enter your own credentials (this is required due to common use 

of devices - agrē needs to confirm the logged in user is the same user processing the return) 

• If you do not have override permission, another user with override permission (e.g. your 

supervisor) must enter their credentials. 

Scan the item. It will be added to the POS Invoice with a negative quantity. 

You will also be prompted to enter Override Credentials if you Add Product with a negative quantity. 

 

5. Defective Product to be Returned to Supplier/Manufacturer   

Please consult your supervisor.  

 

6. Returned Product to be Excluded from Inventory   

Please consult with your supervisor .  
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Toolbar Customization 

As you’ll be using Point of Sale invoices on a 

regular basis, add the POS Invoice toolbar 

shortcut if it is not already there. 

 

 
 

 
Window > Customize Toolbar 

Use Up/Down to change the order of the shortcuts. 

 

Configuration Options for POS Invoices 

There are a few POS Invoice configuration options that can be set at the user level to make agrē work 

more like you do. 

Printers & Default Location 

agrē needs to know which printer each user will use for printing POS Invoices on till-tape and which one 

will be used for printing Standard Invoices (the 8½ x 11 ones).  

Note When Quick Print POS is selected, POS Invoices will be sent directly to the 
receipt printer – they will NOT display on screen before printing. 

 
 

Also set a Default Location so agrē will fill  

that in automatically on each POS Invoice. 

File > Config Options > User 
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Font Size 

Select POS Invoice: Large Fonts = Yes if you’d like the fonts and buttons to display a little larger. 
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